Legal Notices

This guide is copyrighted ©2010 by Avid Technology, Inc., (hereafter “Avid”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Avid.


Product features, specifications, system requirements, and availability are subject to change without notice.

Guide Part Number 9329-62659-00 06/10

Documentation Feedback

At Avid, we are always looking for ways to improve our documentation. If you have comments, corrections, or suggestions regarding our documentation, email us at techpubs@avid.com.
# contents

## Chapter 1. Welcome to Pro Tools M-Powered

- Pro Tools M-Powered Systems ................................................................. 1
- Pro Tools M-Powered Capabilities ........................................................... 1
- How Pro Tools M-Powered Differs from Pro Tools LE ................................. 2
- System Requirements and Compatibility................................................... 2
- Conventions Used in This Guide ............................................................. 4

## Chapter 2. Installing Pro Tools on Mac

- Installation Overview .................................................................................. 5
- Uninstalling Pre-Existing M-Audio Drivers ............................................... 5
- Installing M-Audio Drivers ........................................................................ 6
- Connecting Your M-Audio Interface .......................................................... 7
- Installing Pro Tools M-Powered Software .................................................. 7
- Launching Pro Tools M-Powered ............................................................... 8
- Additional Software on the Pro Tools Installer Disc .................................... 9
- Uninstalling Pro Tools .............................................................................. 10

## Chapter 3. Installing Pro Tools on Windows

- Installation Overview .................................................................................. 11
- Uninstalling Pre-Existing M-Audio Drivers ............................................... 11
- Installing M-Audio Drivers ........................................................................ 12
- Connecting Your M-Audio Interface .......................................................... 13
- Installing Pro Tools M-Powered Software .................................................. 13
- Launching Pro Tools M-Powered ............................................................... 15
- Additional Software on the Pro Tools Installer Disc .................................... 16
- Uninstalling Pro Tools .............................................................................. 17
Chapter 4. Configuring Your Pro Tools System .................................................. 19
 Starting Up or Shutting Down Your System ..................................................... 19
 Configuring Pro Tools M-Powered Software ................................................... 20
 Optimizing a Mac System for Pro Tools .......................................................... 28
 Optimizing a Windows System for Pro Tools .................................................... 30

Appendix A. Configuring AMS (Mac OS X Only) ............................................ 35
 Audio MIDI Setup ............................................................................................. 35
 MIDI Patch Name Support ................................................................................. 37

Appendix B. Configuring MIDI Studio Setup (Windows Only) ....................... 39
 MIDI Studio Setup ............................................................................................ 39
 MIDI Patch Name Support ................................................................................. 41

Appendix C. Hard Drive Configuration and Maintenance .................................. 43
 Avoid Recording to the System Drive ............................................................... 43
 Supported Drive Formats and Drive Types ...................................................... 43
 Formatting an Audio Drive ................................................................................ 44
 Partitioning Drives ........................................................................................... 45
 Hard Disk Storage Space .................................................................................... 48

Appendix D. Resources ...................................................................................... 49
 About the Pro Tools Guides ............................................................................... 49
 About www.avid.com ........................................................................................ 50

Index ..................................................................................................................... 51
Welcome to Pro Tools® M-Powered™ from Avid. This guide documents how to install and configure Pro Tools M-Powered software on M-Powered systems.

**Pro Tools M-Powered Systems**

The basic components of an M-Powered system are as follows:

- A qualified M-Audio interface (not included)
- A qualified Mac or Windows computer (not included)
- Pro Tools M-Powered software (included)

⚠️ For a list of qualified M-Audio interfaces and computers, refer to the compatibility information on our website: www.avid.com/compatibility.

**Pro Tools M-Powered Capabilities**

Pro Tools M-Powered software provides the following capabilities:

- Playback of up to 48 mono or stereo digital audio tracks, or a combination of playing back and recording up to 48 mono or stereo digital audio tracks, depending on your computer’s capabilities.
- Up to 128 audio tracks (with up to 48 active tracks), 128 Auxiliary Input tracks, 64 Master Fader tracks, 256 MIDI tracks, and 32 Instrument tracks per session.
- 16-bit or 24-bit audio resolution, at sample rates up to 96 kHz (depending on the M-Audio interface).
- Non-destructive, random-access editing and mix automation.
- Audio processing with up to 10 inserts per track (RTAS® plug-ins or hardware inserts).
- Up to 10 sends per track.
- Up to 32 internal mix busses.

⚠️ Pro Tools M-Powered uses your computer’s CPU to mix and process audio tracks. Computers with faster clock speeds yield higher track counts and more plug-in processing.
How Pro Tools M-Powered Differs from Pro Tools LE

Configuration Dialogs and Procedures

Some Pro Tools M-Powered configuration dialogs differ from the Pro Tools LE configuration dialogs that are presented in the Pro Tools Reference Guide. For specific Pro Tools M-Powered configuration dialogs, see Chapter 2, “Installing Pro Tools on Mac” or Chapter 3, “Installing Pro Tools on Windows.”

Unsupported Options

Pro Tools M-Powered does *not* support the following Pro Tools LE options:

- Complete Production Toolkit
- DV Toolkit 2
- Avid Ethernet-based control surfaces (such as C|24™)
- Avid video peripherals
- HFS+ Disk Support

💡 Pro Tools M-Powered does *support the Music Production Toolkit 2 option.*

System Requirements and Compatibility

Pro Tools M-Powered can be used with a qualified M-Audio interface, running on a qualified Windows or Mac computer.

A DVD drive is required to use the Pro Tools Installer disc.

Avid can only assure compatibility and provide support for hardware and software it has tested and approved.

For complete system requirements and a list of qualified computers, operating systems, hard drives, and third-party devices, visit:

www.avid.com/compatibility
**Pre-Authorized iLok**

M-Powered software is authorized using the iLok USB Smart Key (iLok) from PACE Anti-Piracy.

**MIDI Requirements**

USB, FireWire, and PCI MIDI interfaces work effectively with Pro Tools systems on Mac or Windows. Serial MIDI interfaces are supported on Windows systems only.

**Hard Drive Requirements**

For optimal audio recording and playback, all Pro Tools systems require one or more qualified hard drives.

If you are using an ATA/IDE or FireWire hard drive, initialize your drive with the Disk Utility application included with Apple System software (Mac) or the Windows Disk Management (Windows).

For more information, see Appendix C, “Hard Drive Configuration and Maintenance.”

**Avoid Recording to the System Drive**

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track and plug-in counts.

**Pre-Authorized iLok**

An iLok can hold over 100 authorizations for all of your iLok-enabled software. Once an iLok is authorized for a given piece of software, you can use the iLok to authorize that software on any computer.

Pro Tools M-Powered includes one iLok, which is pre-authorized for Pro Tools M-Powered software.

⚠️ The M-Powered pre-authorized iLok must be inserted in an available USB port on your computer to run Pro Tools M-Powered.

**Avoid Recording to the System Drive**

Avoid recording to your system drive. Recording to the system drive may result in lower track and plug-in counts.

For a list of supported MIDI interfaces and controllers, visit www.avid.com.
Conventions Used in This Guide

All of our guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The names of Commands, Options, and Settings that appear on-screen are in a different font.

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your Pro Tools system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

=-=-=-=-=-= Shortcut show you useful keyboard or mouse shortcuts.

읽 Cross References point to related sections in this guide and other Avid guides.
This chapter contains information for Mac systems only. If you are installing Pro Tools M-Powered on a Windows computer, see Chapter 3, “Installing Pro Tools on Windows.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

### Installation Overview

Installation of Pro Tools M-Powered on a Mac includes the following steps:

1. “Uninstalling Pre-Existing M-Audio Drivers” on page 5.
6. Configuring your system for improved performance (see Chapter 4, “Configuring Your Pro Tools System”).
7. Making audio connections to the M-Audio interface. (See your M-Audio documentation for details.)

⚠️ Before you begin the installation process, make sure you disconnect your M-Audio interface if it’s plugged into your computer.

### Uninstalling Pre-Existing M-Audio Drivers

Before you install Pro Tools M-Powered, you must first uninstall any pre-existing M-Audio drivers. If your system does not have M-Audio drivers on it, you can skip this section and continue with “Installing M-Audio Drivers” on page 6.

⚠️ If you are using multiple interfaces, follow these same steps for uninstalling the drivers for all your interfaces.

Using multiple M-Audio interfaces at the same time is not supported in Pro-Tools M-Powered.
To uninstall a pre-existing M-Audio driver from your computer:

1. Disconnect your M-Audio device before proceeding.
2. Visit the support page of the M-Audio website (http://www.m-audio.com/drivers).
3. Go to Drivers and Software Search to locate the latest driver for your M-Audio interface.
4. Follow the on-screen instructions to download the correct driver for your M-Audio device.
5. Double-click the driver package to extract the disk image and open the Drivers Installer/Uninstaller dialog.
6. Click Uninstaller. (Scissors icon)
7. Following the remaining on-screen instructions, then shut down your computer.

---

**Installing M-Audio Drivers**

Follow these steps below to install the most current drivers from the M-Audio website.

If you do not have access to the web, use your M-Audio Driver disc to install the driver for your interface. (Follow the instructions that came with the device.)

⚠️ *Pro Tools will not see your M-Audio interface if you do not install the M-Audio drivers.*

To install the M-Audio driver for your M-Audio interface

1. Disconnect your M-Audio device before proceeding.
2. Visit the support page of the M-Audio website (http://www.m-audio.com/drivers).
3. Go to Drivers and Software Search to locate the latest driver for your M-Audio interface.
4. Follow the on-screen procedures to download your driver.
5. Double-click the driver package to extract the dmg and see the Drivers Installer/Uninstaller dialog.
6. Click the installer (the box and arrow icon)
7. Following the remaining on-screen instructions, then shut down your computer.
Connecting Your M-Audio Interface

To connect an M-Audio interface:

1. Connect your M-Audio interface (USB, PCI, or FireWire) according to the instructions that came with it.

   If you are using an M-Audio FireWire interface, do the following:
   Once your computer has shut down completely, connect your FireWire interface and power it on.

2. Turn on your computer.

   In your M-Audio Control Panel, make sure that output channels 1 and 2 are not set to –Infinity (–∞).

Installing Pro Tools M-Powered Software

After the Apple System software settings are configured and you have installed your M-Audio interface and drivers, you are ready to install Pro Tools M-Powered.

To install Pro Tools M-Powered:

1. Make sure you are logged in as an Administrator for the account where you want to install Pro Tools.

   When the installation is complete, you will need to reboot your computer.

   For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2. Insert the Pro Tools M-Powered Installer disc in your DVD drive.

3. On the Installer disc, locate and double-click Install Pro Tools MP.mpkg.

   **Install Pro Tools MP.mpkg icon**

4. Follow the on-screen instructions to proceed with installation.

5. Click Continue each time you are prompted.

6. At the Installation Type page, do one of the following:
   - To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.
   - or –
   - Select (or deselect) a custom configuration of Installation options (see “Installation Options” on page 8) and click Continue.

7. Click Install.

8. If prompted, enter your Administrator password and click OK to authenticate the installation.

9. Follow the remaining on-screen instructions.

10. When installation is complete, click Restart.

   The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 9.
Installation Options

Pro Tools M-Powered Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the re-veal triangle for the Pro Tools M-Powered 8.0 option in the installer, and deselect any of the following options that you do not want installed.

Application Files (Required for Pro Tools) Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including DigiRack plug-ins, free Bomb Factory plug-ins, Eleven Free, TL Utilities, D-Fi and Maxim plug-ins. For more information, see the Audio Plug-Ins Guide.

Pro Tools Creative Collection Options

Select any of the Pro Tools Creative Collection options you want installed. For more information, see the Audio Plug-Ins Guide.

Effect Plug-Ins Installs six free virtual instrument plug-ins from Avid’s AIR group.

Virtual Instruments Installs 20 free effects plug-ins from Avid’s AIR group.

Virtual Instrument Content Installs sample content for AIR virtual instruments.

⚠️ Virtual Instrument content is very large and may take up to 20 minutes to install. During this time, the progress bar may not appear to move but your software is still installing. Do not terminate your installation.

Additional Options

The Pro Tools M-Powered installer provides the following additional option to install along with Pro Tools software and plug-ins.

MIDI I/O Driver The MIDI I/O™ Driver is required if you are using the MIDI I/O interface.

Launching Pro Tools M-Powered

To use Pro Tools M-Powered with an M-Audio interface, you must have an iLok with a license authorizing the version of M-Powered software that you have installed. One pre-authorized iLok is included with the Pro Tools M-Powered package.

To authorize Pro Tools M-Powered software:

1. Make sure your M-Audio interface is connected to your computer and powered on.

2. Insert the pre-authorized iLok into any available USB port on your computer.

3. Click the Pro Tools M-Powered shortcut in your Dock, (or the application in Macintosh HD/Applications/Digidesign/Pro Tools).

⚠️ Do not remove the iLok during Pro Tools launch or use.

4. Use the Quick Start dialog to do one of the following:
   - Create a new session from template.
   - Create a new blank session.
   - Open any other session on your system.
Additional Software on the Pro Tools Installer Disc

The Pro Tools M-Powered Installer disc provides additional software for your system, including a Pro Tools demo session.

⚠️ Check your Pro Tools Installer disc for additional software and installers.

Third-Party Applications and Plug-Ins

Your Pro Tools package also includes several free applications and plug-ins from selected Avid Third Party developers. Once you’ve completed your Pro Tools installation, you can install these separately.

Installers are located on your Pro Tools M-Powered Installer disc in the Additional Files/3rd Party Content folder.

Pro Tools Demo Session

The Pro Tools M-Powered Installer disc includes a demo session that you can use to verify that your system is working.

The demo session for Pro Tools M-Powered is named “Filtered Dream.”

⚠️ Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 44.

To install the demo session:

1. Insert the Pro Tools M-Powered Installer disc into your DVD drive.
2. On the Pro Tools M-Powered Installer disc, locate and open the Additional Files/Pro Tools Demo Sessions Installer folder.
3. Double-click Install demo session.pkg.
4. Follow the on-screen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the installation.
6. When installation is complete, click Close.

The demo session can be opened by double-clicking the Filtered Dream.ptf file (located in the Filtered Dream Demo Session folder).
Uninstalling Pro Tools

If you need to remove Pro Tools software from your computer, use the Uninstaller application.

To uninstall Pro Tools from your computer:

1. Make sure you are logged in as an Administrator for the account where Pro Tools is installed.

   For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

2. Go to Applications/Digidesign/Pro Tools/Pro Tools Utilities and double-click Uninstall Pro Tools.

3. Click Continue to proceed with the uninstall.

4. Choose the type of uninstall you want to perform:

   Safe Uninstall Leaves certain plug-ins and system files needed for compatibility with some Avid products. Use Safe Uninstall if you are using an Avid application or preparing to update to a CS (customer support) release.

   Clean Uninstall Removes all Pro Tools files, including system files, Avid plug-ins, and MIDI patch names. Use Clean Uninstall whenever you are preparing to upgrade, or to troubleshoot from a clean system.

5. Click Uninstall.

6. Enter your Administrator password and click OK.

7. Click Finish to close the Installer window.
This chapter contains information for Windows systems only. If you are installing Pro Tools M-Powered on a Mac computer, see Chapter 2, “Installing Pro Tools on Mac.”

⚠️ Before installing this version of Pro Tools, refer to the Read Me information included on the Pro Tools Installer disc.

**Installation Overview**

Installing Pro Tools M-Powered on a Windows computer includes the following steps:

1. “Uninstalling Pre-Existing M-Audio Drivers” on page 11
2. “Installing M-Audio Drivers” on page 12
5. “Launching Pro Tools M-Powered” on page 15. (This step includes inserting the pre-authorized iLok into an available USB port on your computer.)
6. Configuring your system for improved performance (see Chapter 4, “Configuring Your Pro Tools System”).
7. Making audio connections to the M-Audio interface. (See your M-Audio documentation for details.)

⚠️ Before you begin the installation process, make sure you disconnect your M-Audio interface if it’s plugged into your computer.

**Uninstalling Pre-Existing M-Audio Drivers**

Before you install Pro Tools M-Powered, you must first uninstall any pre-existing M-Audio drivers. If your system does not have M-Audio drivers on it, you can skip this section and continue with “Installing M-Audio Drivers” on page 12.

⚠️ If you are using multiple interfaces, follow these same steps for uninstalling the drivers for all your interfaces.

*Using multiple M-Audio interfaces at the same time is not supported with Pro Tools M-Powered.*
To uninstall a pre-existing M-Audio driver from your computer:

1. Disconnect your M-Audio device before proceeding.
2. Visit the support page of the M-Audio website (http://www.m-audio.com/drivers).
3. Go to Drivers and Software Search to locate the latest driver for your M-Audio interface.
4. Follow the on-screen instructions to download and run the correct driver for your M-Audio device.
5. When the installer detects a pre-existing M-Audio driver, an Installation dialog appears.
6. Select Remove and then click Next and follow the remaining on-screen instructions.
7. When the process is complete, shut down your computer.

Installing M-Audio Drivers

Follow these steps below to install the most current drivers from the M-Audio web site.

If you do not have access to the web, use your M-Audio Driver disc to install the driver for your interface. (Follow the instructions that came with it.)

⚠️ Pro Tools will not see your M-Audio interface if you do not install the M-Audio drivers.

To install the M-Audio driver for your M-Audio interface:

1. Disconnect your M-Audio device before proceeding.
2. Visit the support page of the M-Audio website (http://www.m-audio.com/drivers).
3. Go to Drivers and Software Search to locate the latest driver for your M-Audio interface.
4. Follow the on-screen instructions to download and run the correct driver for your M-Audio device.
5. When the installation is complete, shut down your computer.
Connecting Your M-Audio Interface

To connect an M-Audio interface:

1. Connect your M-Audio interface (USB, PCI, or FireWire) according to the instructions that came with it.

   - If you are using an M-Audio FireWire interface, do the following:
     
     Once your computer has shut down completely, connect your FireWire interface and power it on.

2. Turn on your computer.

3. When your system recognizes the new hardware, run the Found New Hardware Wizard. Follow the on-screen instructions.

   - If you are prompted to run the Found New Hardware Wizard a second time, run it again.

   - In your M-Audio Control Panel, make sure that output channels 1 and 2 are not set to –Infinity (–\(\infty\)).

Installing Pro Tools M-Powered Software

After your M-Audio interface is installed and connected, and the driver for your interface is installed, you are ready to install Pro Tools software.

To install Pro Tools M-Powered:

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.

   - When the installation is complete, you will need to reboot your computer.

2. Insert the Pro Tools LE Installer disc in your DVD drive and do one of the following:

   - If Windows AutoRun is enabled, a mini-browser appears. Select Install Pro Tools LE to begin your installation.
   - or –
   - If Windows AutoRun is disabled, locate and double-click Setup.exe. on the Installer disc.

3. Follow the on-screen instructions to proceed with installation and click Next when prompted.

4. To install the complete compliment of Pro Tools software and plug-ins, leave Pro Tools selected.
At the Select Features page, do one of the following:

- To install all Pro Tools application files and free plug-in suites (and associated content), leave the default Installation options selected and click Continue.

- or -

- Select (or deselect) a custom configuration of Installation options (see "Installation Options" on page 14) and click Continue.

6 Click Next.

7 Click Install.

⚠️ In Windows 7 and Windows Vista, a series of Windows Security dialogs may appear. Click “Install” on each one until they go away.

⚠️ In Windows XP, a series of Software Installation dialogs about the driver not passing Windows Logo testing may appear. Click Continue Anyway on each one until they go away.

8 Wait for the installer to finish installing all software components, drivers, and PACE System files before proceeding to the next step.

9 When installation is complete, click Finish.

⚠️ The Pro Tools Installer disc includes additional software for your system. For more information, see “Additional Software on the Pro Tools Installer Disc” on page 16.

### Installation Options

#### Pro Tools M-Powered Options

To install a subset of Pro Tools software and plug-ins (and associated content), click the plus (+) next to Pro Tools M-Powered option in the Select Features page of the installer, and deselect any of the following options that you do not want installed.

#### Application Files (Required for Pro Tools)

Installs the Pro Tools application and supporting library files needed to run Pro Tools. This option must be selected to install Pro Tools.

#### DigiRack Plug-Ins

Installs free plug-ins including DigiRack plug-ins, free Bomb Factory plug-ins, Eleven Free, TL Utilities, and D-Fi and Maxim plug-ins. For more information, see the Audio Plug-Ins Guide.

#### Pro Tools Creative Collection Options

Select any of the Pro Tools Creative Collection options you want installed. For more information, see the Audio Plug-Ins Guide.

#### Effect Plug-Ins

Installs 6 free virtual instrument plug-ins from Avid’s AIR group.

#### Virtual Instruments

Installs 20 free effects plug-ins from Avid’s AIR group.

#### Virtual Instrument Content

Installs sample content for AIR virtual instruments.

⚠️ Virtual Instrument content is very large and may take up to 20 minutes to install. During this time, the progress bar may not appear to move but your software is still installing. Do not terminate your installation.
Additional Options

The Pro Tools installer provides the following additional option to install along with Pro Tools software and plug-ins.

Command|8 Controller and Driver  The Command|8® driver is required if you are using the Avid Command|8 control surface.

Installing QuickTime

QuickTime is required for Pro Tools if you plan to include movie files, or import MP3 or MP4 (AAC) files in your sessions. QuickTime for Windows XP is available as a free download from the Apple website (www.apple.com).

⚠️ For information on which version of QuickTime is compatible with your version of Pro Tools, visit the compatibility pages of our website: (www.avid.com).

To install QuickTime:

2. Download the QuickTime installer application to your computer.
3. Double-click the QuickTime installer application and follow the on-screen installation instructions.
4. Restart your computer.

Launching Pro Tools M-Powered

To use Pro Tools M-Powered with an M-Audio interface, you must have an iLok with a license authorizing the version of M-Powered software that you have installed. One pre-authorized iLok is included with the Pro Tools M-Powered package.

To authorize Pro Tools M-Powered software:

1. Make sure your M-Audio interface is connected to your computer and powered on.
2. Insert the pre-authorized iLok into an available USB port on your computer.
3. Double-click the Pro Tools M-Powered shortcut on your desktop (or the application in Program Files\Digidesign\Pro Tools).
4. Use the Quick Start dialog to do one of the following:
   - Create a new session from template.
   - Create a new blank session.
   - Open any other session on your system.

⚠️ Do not remove the iLok during Pro Tools launch or use.
Additional Software on the Pro Tools Installer Disc

The Pro Tools Installer disc provides additional software for your system, including a Pro Tools demo session.

To install the demo session:

1. Insert the Pro Tools M-Powered Installer disc in your DVD drive.
2. On the Pro Tools M-Powered Installer disc, locate and open the Additional Files\Pro Tools Demo Sessions Installer folder.
3. Double-click Demo Session Setup.exe.
4. Follow the on-screen instructions.
5. When prompted, select your audio drive as the install location and click Next to begin the install.
6. When installation is complete, click Finish.

The demo session can be opened by double-clicking the Filtered Dream.ptf file (located in the Filtered Dream Demo Session folder).

Pro Tools Demo Session

The Pro Tools M-Powered Installer disc includes a demo session that you can use to verify that your system is working.

The demo session for Pro Tools M-Powered is named “Filtered Dream.”

⚠️ Before installing the demo session to your audio drive, make sure the drive is configured as described in “Formatting an Audio Drive” on page 44.

Third-Party Applications and Plug-Ins

Your Pro Tools package also includes several free applications and plug-ins from selected Avid Third Party developers. Once you've completed your Pro Tools installation, you can install these separately.

Installers are located on your Pro Tools LE Installer disc in the Additional Files\3rd Party Content folder.
Uninstalling Pro Tools

If you need to remove Pro Tools software from your computer, use the Uninstaller application.

To uninstall Pro Tools from your computer:

1. Start Windows, logging in with Administrator privileges. For details on Administrator privileges, refer to your Windows documentation.
2. Go to C:\Program Files\Digidesign\Pro Tools\Pro Tools Utilities and double-click Uninstall Pro Tools.exe.
3. Click Next.
4. Click Uninstall to proceed with the uninstall.
After you have connected your system and installed Pro Tools software, you are ready to start up and configure your Pro Tools system.

**Starting Up or Shutting Down Your System**

To ensure that the components of your Pro Tools system communicate properly with each other, you need to start them in a particular order.

**Start up your Pro Tools system in this order:**
1. Lower the volume of all output devices in your system.
2. Turn on any external hard drives. Wait approximately ten seconds for them to spin up to speed.
3. Turn on any control surfaces.
4. Turn on any MIDI interfaces, MIDI devices, or synchronization peripherals.
5. For M-Powered systems that use hardware requiring external power, turn on the hardware.
6. Turn on your computer.
7. Launch Pro Tools or any third-party audio or MIDI applications.

**Shut down your Pro Tools system in this order:**
1. Quit Pro Tools and any other running applications.

   *To quit Pro Tools, choose Pro Tools > Quit (Mac) or File > Exit (Windows).*
2. Turn off or lower the volume of all output devices in your system.
3. Turn off your computer.
4. For M-Powered systems that use hardware requiring external power, turn off the hardware.
5. Turn off any MIDI interfaces, MIDI devices, or synchronization peripherals.
6. Turn off any control surfaces.
7. Turn off any external hard drives.
Configuring Pro Tools M-Powered Software

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools lets you adjust the performance of your system by changing system settings that affect its capacity for processing, playback, and recording.

In most cases, the default settings for your system provide optimum performance, but you may want to adjust them to accommodate large or processing-intensive Pro Tools sessions.

For some M-Audio interfaces, you can only change the Hardware Buffer Size in the M-Audio interface’s control panel (while Pro Tools is closed). For more information, see “Pro Tools Hardware Settings and M-Audio Control Panel” on page 25.

Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) controls the size of the buffer used to handle host processing tasks such as Real-Time AudioSuite (RTAS) plug-ins. The H/W Buffer setting can also be used to manage monitoring latency.

- Lower Hardware Buffer Size settings reduce monitoring latency, and are useful when you are recording live input.
- Higher Hardware Buffer Size settings allow for more audio processing and effects, and are useful when you are mixing and using more RTAS plug-ins.

⚠️ In addition to causing slower screen response and monitoring latency, higher Hardware Buffer Size settings can increase the latency caused by RTAS plug-ins, and affect the accuracy of plug-in automation, mute data, and MIDI track timing.

To change the Hardware Buffer Size:

2. From the H/W Buffer Size pop-up menu, select the audio buffer size, in samples.
3. Click OK.
Host Processors

The Host Processors setting lets you manage multi-processor support for RTAS (Real-Time AudioSuite) plug-in processing.

Used in combination with the CPU Usage Limit setting, the Host Processors setting lets you control the way RTAS and other host-based processing tasks are carried out by the system.

For example:

- For sessions with large numbers of RTAS plug-ins, you can allocate 2 or more processors to RTAS processing and set a high CPU Usage Limit.
- For sessions with few RTAS plug-ins, you can allocate fewer processors to host processing and set a low CPU Usage Limit to leave more CPU resources available for automation accuracy, screen response, and video.
- Depending on the importance of video and overall screen response, and on the density of automation being employed, try different combinations of Host Processors and CPU Usage Limit settings to achieve the best results. For example, to improve screen response in a medium-sized session using a moderate number of RTAS plug-ins, try reducing the number of RTAS plug-ins, but keep the CPU Usage Limit set to the maximum (up to 99% on a single processor system).

To set the number of Host Processors:

2. From the Host Processors pop-up menu, select the number of available processors you want to allocate. The number of processors varies depending on your computer:
   - Select 1 Processor to limit processing to one CPU in the system.
   - Choose 2 Processors to enable load balancing across two available processors.
   - On systems running four or more processors, choose the number of processors for processing.
3. Click OK.

System Usage Window and Processing

The System Usage window (Window > System Usage) displays the combined amount of processing occurring on all enabled processors with a single indicator, regardless of how many processors are available in the system. If the System Usage Window shows that you are at the limit of available resources, increase the number of processors and adjust the CPU Usage Limit setting.
**CPU Usage Limit**

The CPU Usage Limit setting controls the percentage of CPU resources allocated to Pro Tools host processing tasks. Used in combination with the RTAS Processors setting, the CPU Usage Limit setting lets you control the way Pro Tools tasks are carried out by the system.

- **Lower** CPU Usage Limit settings limit the effect of Pro Tools processing on other CPU-intensive tasks, such as screen redraws, and are useful when you are experiencing slow system response, or when running other applications at the same time as Pro Tools.

- **Higher** CPU Usage Limit settings allocate more processing power to Pro Tools, and are useful for playing back large sessions or using more RTAS plug-ins.

The maximum available CPU Usage Limit depends on the number of processors in your computer and on the number of processors you specify for RTAS processing. This value can range from 85% for single-processor computers, and 99% for multiprocessor computers (which dedicate one entire processor to Pro Tools).

On multiprocessor computers, the maximum CPU Usage Limit is reduced when you use all your processors (as selected in the Host Processors pop-up menu). For example, on dual-processors, the limit is 90%, On four-processor computers, the limit is 95%.

⚠️ *Increasing the CPU Usage Limit may slow down screen responses on slower computers.*

**To change the CPU Usage Limit:**

2. From the CPU Usage Limit pop-up menu, select the percentage of CPU processing you want to allocate to Pro Tools.
3. Click OK.

**Host Engine (Error Suppression)**

The Host Engine option determines error reporting during playback and recording. This is especially useful when working with instrument plug-ins.

You should only enable error suppression if you are experiencing frequent RTAS errors that are interrupting your creative workflow. When error suppression is enabled, you can experience a degradation of audio quality. However, this may be acceptable in order to avoid interrupting playback and recording when working with instrument plug-ins. Be sure to disable error suppression when you need to ensure the highest possible audio quality, such as for a final mix.

**To enable error suppression:**

2. Select Host Engine: Ignore Errors During Playback/Record.
3. You can also select Minimize Additional I/O Latency.
4. Click OK.

**Error Suppression Options**

**Ignore Errors During Playback/Record**

When enabled, Pro Tools continues to play and record even if the RTAS processing requirements exceed the selected CPU Usage Limit. This can result in pops and clicks in the audio, but does not stop the transport.
**Minimize Additional I/O Latency**

When enabled, any additional latency due to suppressing errors during playback and record is minimized to 128 samples. Suppressing errors requires at least 128 samples of additional buffering on some systems. If this option is disabled, the buffer is half the H/W Buffer Size, or at least 128 samples (whichever is greater). If you are on an older, slower computer, you may want to disable this option to avoid adverse performance.

This option is only available if the Ignore Errors During Playback/Record option is enabled.

**DAE Playback Buffer Size**

The DAE Playback Buffer Size setting determines the amount of memory DAE allocates for disk buffers. In addition to levels, the DAE Playback Buffer Size shows values in milliseconds, which indicate the amount of audio buffered when the system reads from disk.

The optimum DAE Playback Buffer Size for most disk operations is 1500 msec; Level 2 (Default).

- DAE Playback Buffer Size settings lower than 1500 msec; Level 2 (Default) may improve playback and recording initiation speed, as well as preview in context in DigiBase browsers. However, a lower setting may make it difficult to play or record tracks reliably with sessions containing a large number of tracks or a high density of edits, or with systems that have slower or heavily-fragmented hard drives.

- DAE Playback Buffer Size settings higher than 1500 msec; Level 2 (Default) allow higher track count, higher density of edits in a session, or the use of slower hard drives. However, a higher setting may increase the time lag when starting playback or recording, starting preview in context from DigiBase browsers, or cause a longer audible time lag while editing during playback.

💡 *Using a larger DAE Playback Buffer Size leaves less system memory for other tasks. The default setting of 1500 msec (Level 2) is recommended unless you are encountering –9073 (“Disk too slow or fragmented”) errors.*

**To change the DAE Playback Buffer Size:**


2. From the DAE Playback Buffer pop-up menu, select a buffer size. Memory requirements for each setting are shown at the bottom of the Playback Engine dialog.

3. Click OK.

If Pro Tools needs more system memory for the DAE Playback Buffer, it will prompt you to restart your computer.
Cache Size

The Cache Size setting determines the amount of memory DAE allocates to pre-buffer audio for playback and looping when using Elastic Audio.

Minimum Reduces the amount of system memory used for disk operations and frees up memory for other system tasks. However, performance when using Elastic Audio features may decrease.

Normal Is the optimum Cache Size for most sessions.

Large Improves performance when using Elastic Audio features, but it also decreases the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Cache Size leaves less system memory for other tasks. The default setting of Normal is recommended unless you are encountering -9500 (“Cache too small”) errors.

To change the Cache Size:

2. From the Cache Size pop-up menu, select a disk cache size.
3. Click OK.

Plug-In Streaming Buffer Size

(Structure Plug-In Only)

This setting appears in the Playback Engine dialog only if Structure, Structure LE, or Structure Free is installed on your system. The Plug-In Streaming Buffer Size determines the amount of memory DAE allocates for streaming playback from disk with the Structure plug-in. This setting only affects playback if disk streaming is activated in Structure’s plug-in controls (see the Air Virtual Instruments Guide for more information).

The optimum Plug-In Streaming Buffer Size for most sessions is 250 ms (Level 2).

- Plug-In Streaming Buffer Size settings lower than 250 msec (Level 2) reduce the amount of system memory used for sample playback and frees up memory for other system tasks. However, audio quality of sample playback may decrease.
- Plug-In Streaming Buffer Size settings higher than 250 msec (Level 2) improve the audio quality of sample playback, but they also decrease the amount of memory available for other system tasks, such as RTAS processing.

💡 Using a larger Plug-In Streaming Buffer Size leaves less system memory for other tasks. The default setting of 250 ms (Level 2) is recommended unless you are experiencing problems with the audio quality of sample playback.

To change the Plug-In Streaming Buffer Size:

2. From the Plug-In Streaming Buffer Size pop-up menu, select a buffer size.
3. Click OK.
Optimizing the Plug-In Streaming Buffer Size

(Structure Plug-In Only)

This option appears in the Playback Engine dialog only if one of the Structure sampler instrument plug-in is installed on your system. This option is useful when you are playing samples from the same drive that contains audio for the current session. When this option is selected, Pro Tools automatically optimizes the size of the Plug-In Streaming Buffer to facilitate disk access from both Pro Tools and Structure. The Plug-In Streaming Buffer Size pop-up menu is unavailable when this option is selected.

To set Pro Tools to optimize the Plug-In Streaming Buffer Size:

2. Select the Optimize for Streaming Content option.
3. Click OK.

Pro Tools Hardware Settings and M-Audio Control Panel

The Hardware Setup dialog in Pro Tools (Setup > Hardware) displays the name of your M-Audio peripheral, and tells you that various hardware functions can be changed in the M-Audio Control Panel.

Using the M-Audio Control Panel, you can change settings in the following areas:

- Mixer Settings
- Output Settings
- Hardware Settings (including sample rate, hardware buffer size, and sync source).

💡 You can set the sample rate when creating a new Pro Tools session by selecting a different sample rate in the New Session dialog. (Refer to the Pro Tools Reference Guide for details.)

To change M-Audio Control Panel settings:

1. If Pro Tools M-Powered is running, exit Pro Tools.
2. Launch the M-Audio Control Panel as follows:
   - For FireWire interfaces, launch M-Audio FW Audio.
   - For PCI interfaces, launch M-Audio Delta Audio.
   - For USB Interfaces, launch the M-Audio control panel with the name of your interface.
3. To change settings in the M-Audio Control Panel, refer to the documentation that came with your M-Audio interface.
4. When finished, close the M-Audio Control Panel.
Sync Source (Pro Tools Clock Source)

If your M-Audio interface has digital I/O (such as a S/PDIF I/O), use the M-Audio Control Panel to select the Sync Source for the system.

⚠️ If Pro Tools M-Powered is running, exit Pro Tools.

1. Launch the M-Audio Control Panel as follows:
   - For FireWire interfaces, launch M-Audio FW Audio.
   - For PCI interfaces, launch M-Audio Delta Audio.
   - For USB Interfaces, launch the M-Audio control panel with the name of your interface.

2. Click the Hardware tab.

3. Select a Sync Source.

4. Click OK.

Your digital input device must be connected and turned on. If your input device is not turned on, leave the Sync Source set to Internal.

For more information on selecting the Sync Source for your M-Audio interface, refer to your M-Audio interface documentation.

Low Latency Monitoring

Direct or low-latency monitoring is not available from within Pro Tools M-Powered.

However, with M-Audio devices that have Control Panel mixers with a direct monitoring feature, it is possible to use this feature as a low-latency monitoring path while recording in Pro Tools M-Powered.

To use the M-Audio mixer direct monitoring feature while recording:

1. In Pro Tools, record-enable the tracks you want to record and mute their output.

2. Open the M-Audio Control Panel for your M-Audio interface.

3. In the Control Panel mixer for your interface, route the input channels you want to monitor to the main outputs of the mixer (usually Outputs 1–2) by clicking the corresponding output control.

Control Panel mixer for M-Audio FireWire 410

Mixer output 1–2 control
4 Adjust the output level and balance with the Control Panel mixer volume and pan controls.

5 In Pro Tools, begin recording.

6 To listen back to the recorded tracks, unmute the tracks in Pro Tools and begin playback.

7 When you are finished recording, turn off the mixer output control in the Control Panel mixer.

For more information on direct monitoring with your M-Audio device, refer to its User Guide.

### Configuring I/O Setup

Using the I/O Setup dialog, you can label Pro Tools input, output, insert, and bus signal paths. The I/O Setup dialog provides a graphical representation of the inputs, outputs, and signal routing of the M-Audio interface.

Pro Tools M-Powered bypasses the M-Audio mixer that is displayed in the M-Audio Control Panel. The interface’s hardware inputs and outputs show up directly in Pro Tools I/O Setup.

Pro Tools M-Powered has default I/O Setup settings that will get you started. Use the I/O Setup dialog only if you want to rename or remap the default I/O paths.

#### To rename I/O paths in I/O Setup:

1. Choose Setup > I/O.

2. Click the Input, Output, Insert, or Bus tab to display the corresponding connections.

3. To change the name of a path or subpath, double-click directly on the Path Name, type a new name for the path, and press Enter.

4. Click OK.

See the Pro Tools Reference Guide (Help > Pro Tools Reference Guide) for more information on renaming I/O paths.
Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools, do one of the following:

- On Mac, configure your MIDI setup with Audio MIDI Setup. See Appendix A, “Configuring AMS (Mac OS X Only)” for details.

  – or –


Backing Up Your System Configuration

After configuring your system and Pro Tools, you should save an image of your system drive using a backup utility such as Norton Ghost. By doing this, you can quickly restore your system configuration and settings if you encounter any problems.

Optimizing a Mac System for Pro Tools

To ensure optimum performance with Pro Tools, configure your computer before using Pro Tools software.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges in Mac OS X, see your Apple OS X documentation.

⚠️ Do not use the Mac OS X automatic Software Update feature, as it may upgrade your system to a version of Mac OS that has not yet been qualified for Pro Tools. For details on qualified versions of Mac OS, visit www.avid.com/compatibility.

Turning Off Software Update

To turn off the Software Update feature:

1. Choose System Preferences from the Apple menu and click Software Update.

2. Click the Scheduled Check tab.

3. Deselect “Check for Updates.”

Turning Off Energy Saver

To turn off the Energy Saver feature:

1. Choose System Preferences from the Apple menu and click Energy Saver.

2. Do the following:
   - Set the computer sleep setting to Never.
   - Set the display sleep setting to Never.
   - Deselect the Put the hard disk(s) to sleep when possible option.
Disable or Reassign Mac Keyboard Shortcuts Used by Pro Tools

To have the full complement of Pro Tools keyboard shortcuts, you need to disable or reassign any conflicting Mac OS X Keyboard Shortcuts in the Apple System Preferences, including the following:

- “Show Help menu”
- Under “Keyboard Navigation”
  - “Move focus to the window drawer”
- Under “Dock, Exposé, and Dashboard”
  - “Automatically hide and show the Dock”
  - “All windows”
  - “Application windows”
  - “Desktop”
  - “Dashboard”
  - “Spaces”
- Under “Spotlight”
  - “Show Spotlight search field”
  - “Show Spotlight window”

For a complete list of Pro Tools keyboard shortcuts, see the Keyboard Shortcuts Guide (Help > Keyboard Shortcuts).

To disable or reassign Mac OS X keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Keyboard.
2. Click the Keyboard Shortcuts tab.
3. Do one of the following:
   - Deselect the Mac OS X options that conflict with Pro Tools keyboard shortcuts.
   - Assign different, non-conflicting keyboard shortcuts to the corresponding Mac OS X options.

Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign the Spaces keyboard shortcuts to avoid conflicts with important Pro Tools keyboard shortcuts. You can reassign Spaces keyboard shortcuts to use a combination of modifier keys (Command+Option+Control+Shift) in addition to the default Spaces keyboard shortcut assignments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use modifier key combinations that do not conflict with Pro Tools keyboard shortcuts:

1. Choose System Preferences from the Apple menu and click Exposé & Spaces.
2. Click the Spaces tab.
3. Ensure that Enable Spaces is selected.
4. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+F8” from the “To activate Spaces” pop-up menu.
5. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Arrow Keys” from the “To switch between spaces” pop-up menu.
6. Press and hold Command+Option+Control+Shift and select “Control+Option+Shift+Command+Number Keys” from the “To switch directly to a space” pop-up menu.
Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically indexes files and folders on local hard drives in the background. In most cases, this is not a concern for normal Pro Tools operation. However, if Spotlight starts indexing drives while recording in a Pro Tools session with high track counts for an extended period of time, it can adversely affect Pro Tools system performance. You may want to disable Spotlight indexing for all local drives before using Pro Tools for big recording projects.

Disabling Spotlight indexing also disables the Find function in Mac OS X.

To disable Spotlight indexing:
1. Choose System Preferences from the Apple menu and click Spotlight.
2. In the Spotlight window, click the Privacy tab.
3. To prevent indexing of a drive, drag its icon from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, enable journaling.

To enable journaling:
1. Launch the Disk Utility application, located in Macintosh HD/Applications/Utilities.
2. Select the volume in the left column of the Disk Utility window.
3. Select Enable Journaling in the toolbar.

Optimizing a Windows System for Pro Tools

To ensure optimum performance with Pro Tools M-Powered, configure your computer before using Pro Tools hardware and software.

For Mac System Optimization, see “Optimizing a Mac System for Pro Tools” on page 28.

Before configuring your computer, make sure you are logged in as an Administrator for the account where you want to install Pro Tools. For details on Administrator privileges, see your Windows documentation.

Required Optimizations

To ensure optimum performance with Pro Tools, configure the following settings before using Pro Tools hardware and software.

When you are finished changing Windows system settings, restart your computer.

Enabling DMA

Enabling your computer’s DMA (Direct Memory Access) frees up CPU bandwidth so your computer can do other Pro Tools tasks.

In most cases the DMA option will already be set correctly, as Windows detects and activates DMA mode by default.
To enable DMA for any IDE hard drives:

1. Choose Start.
2. Right-click Computer (Windows 7, Windows Vista) or My Computer (Windows XP) and choose Manage.
3. In the left pane of Computer Management under System Tools, click on Device Manager.
4. In the right pane, click the triangle (Windows 7) or the plus (+) sign (Windows Vista, Windows XP) next to IDE ATA/ATAPI Controllers.
5. Double-click on an IDE Channel.
6. Click the Advanced Settings tab.
7. Under Device Properties, check the box Enable DMA (Windows 7, Windows Vista) or under each listed Device, set the Transfer Mode to DMA if available (Windows XP).
8. Click OK.
9. Repeat for each IDE Channel.

Configuring Windows Power Management Settings

Pro Tools requires maximum CPU performance for optimal RTAS processing and disk streaming. For best performance, use the following recommended Windows Power Management settings.

To configure Windows Power Management Settings (Windows 7, Windows Vista):

1. Choose Start > Control Panel.
2. Click Hardware and Sound > Power Options.
3. In the Power Options control panel, click High Performance.
4. Click Change plan settings.
5. Click Change advanced power settings to change additional settings.
6. Click Hard disk > Turn off hard disk after = Never. You can make optional changes such as disabling sleep and disabling shutting down the monitor.
7. Click OK or click Save changes to save the changes.
8. Close the window.

To configure Windows Power Management Settings (Windows XP):

1. Choose Start > Control Panel.
2. Double-click Power Options.
3. Click the Power Schemes tab.
4. From the Power Schemes pop-up menu, select Always On.
5. Verify that the following settings are set to Never:
   - Turn off hard disks
   - System standby
   - System hibernates
6. Click OK.
Disabling User Account Control
(Windows 7, Windows Vista)

Some third-party applications that interface with Pro Tools may require UAC to be disabled for proper operation.

To disable User Account Control (UAC):

1. Choose Start > Control Panel.
2. Click User Accounts and Family Safety.
3. In the User Accounts and Family Safety control panel, click User Accounts.
4. Click Change User Account Control settings (Windows 7) or Turn User Account Control on or off (Windows Vista).
5. Move the User Account Control slider to Never Notify (Windows 7), or deselect the Use User Account Control (UAC) to help protect your computer option (Windows Vista).
6. Click OK.
7. Restart your computer.

Recommended Optimizations

Pro Tools can also be affected by other software and hardware drivers installed on your computer. For best possible performance, it is recommended (but not required) that you do the following:

• Avoid running any unneeded programs at the same time as Pro Tools.
• Turn off any software utilities that run in the background, such as Windows Messenger, calendars, and disk maintenance programs.
• Turn off any non-essential USB devices while running Pro Tools.
• If your video display card supports it, enable Bus Mastering in the manufacturer’s Control Panel. See the manufacturer’s instructions for details.

Optional Optimizations

The following system optimizations may help Pro Tools perform better on some systems. It is recommended that you only try these optimizations if necessary, as they may disable or adversely affect the functionality of other programs on your system.

Disabling Network Cards

If applicable, disable any networking cards (other than a FireWire card that you might use to connect an external drive to your system).

To disable a network card (Windows 7, Windows Vista):

1. Choose Start > Computer.
2. Click System Properties.
3. In the left-hand pane under Control Panel Home, click on Device Manager.
4. In the Device Manager window, double-click Network adapters.
5. Right-click on the network adapter and select Disable.
6. Repeat as necessary for additional network adapters.
7. Close the Device Manager window.
To disable a network card (Windows XP):

1. Right-click My Computer and choose Manage.
2. Under System Tools, select Device Manager.
3. In the right-hand pane, click “+” to reveal Network adapters.
4. In the Device Manager window, double-click Network adapters.
5. Right-click on the network adapter and select Disable.
6. Repeat as necessary for additional network adapters.
7. Close the Computer Management window.

**Adjusting Processor Scheduling**

**To adjust Processor Scheduling performance:**

1. Right-click Computer (Windows 7, Windows Vista) or My Computer (Windows XP) and choose Properties.
2. Click the Advanced system settings link in the left pane (Windows 7, Windows Vista) or the Advanced tab (Windows XP).
3. Under the Performance section, click the Settings button.
4. In the Performance Options window, click the Advanced tab.
5. Under the Processor Scheduling section, select the Background Services option.
6. Click OK to close the Performance Options window.
7. Click OK to close the System Properties window.
8. Restart the computer for the changes to take effect.

**Disabling System Startup Items**

The fewer items in use by your computer, the more resources are available for Pro Tools. Some startup applications may be consuming unnecessary CPU resources, and can be turned off.

If you disable any of the following startup items, do so carefully:

- Portable media serial number (required for some applications that utilize a copy protection key)
- The Plug and Play service
- Event log
- Cryptographic services

**To Disable System Startup Items:**

1. From the Start menu, type “msconfig” in Start Search (Windows 7, Windows Vista) or in Run (Windows XP) and click OK to open the System Configuration Utility.
2. Under the General tab, choose Selective Startup.
3. Deselect Load Startup Items and click OK.
4. Click Restart to restart the computer.
5. After restarting, the computer displays a System Configuration message. Check to see if Pro Tools performance has increased before you deselect the Don’t show this message again option. If performance has not changed, run “msconfig” and return your computer Startup Selection back to Normal Startup - load all device drives and services. Alternatively, try disabling Startup items and non-essential processes individually.
Appendix A

Configuring AMS (Mac OS X Only)

Audio MIDI Setup

Pro Tools recognizes the ports on your MIDI interface as generic ports. With Mac OS X, you use Apple’s Audio MIDI Setup (AMS) utility to identify external MIDI devices connected to your MIDI interface and configure your MIDI studio for use with Pro Tools.

⚠️ To ensure optimum performance, do not change the AMS configuration while Pro Tools is playing back. Stop the Pro Tools transport before launching AMS.

To configure your MIDI studio in AMS:

1. Do one of the following:
   - Launch Audio MIDI Setup (located in Applications/Utilities).
   - or –
   - In Pro Tools, choose Setup > MIDI > MIDI Studio.

2. Click the MIDI Devices tab (or Window > Show MIDI Window). AMS scans your system for connected MIDI interfaces. If your MIDI interface is properly connected, it appears in the window with each of its ports numbered.

3. For any MIDI devices connected to the MIDI interface, click Add Device. A new external device icon with the default MIDI keyboard image will appear.

4. Drag the new device icon to a convenient location within the window.
5 Connect the MIDI device to the MIDI interface by clicking the arrow for the appropriate output port of the device and dragging a connection or “cable” to the input arrow of the corresponding port of the MIDI interface.

6 Click the arrow for the appropriate input port of the device and drag a cable to the output arrow of the corresponding port of the MIDI interface.

7 Repeat steps 3–6 for each MIDI device in your MIDI setup.

To configure an external MIDI device:

1 Select the external device icon and click Show Info (or double-click the new device icon).

2 Select a manufacturer and model for the new device from the corresponding pop-up menus. (If the Manufacturer and Model pop-up menus do not provide a name for your particular device, you can type a name.)

Making MIDI input and output connections

To remove a connection, select the cable and press Delete.

Naming a new MIDI device

For Manufacturer and Model names, AMS refers to one or more files with the suffix “.middev” in the directory Root/Library/Audio/MIDI Devices. Pro Tools installs a file that contains information for many commercially available MIDI devices, named “Digidesign Device List.middev.” If the Manufacturer or Model names for any of your external MIDI devices is not available in the AMS Manufacturer and Model pop-up menus, you can add them by editing the .middev file in any text editor (such as TextEdit).
3 Click the More Information arrow to expand the dialog, then enable the appropriate MIDI channels (1–16) for the Transmits and Receives options. (These determine which channels the device will use to send and receive MIDI.)

4 Click the device image. The window expands to show images for various MIDI devices (such as keyboards, modules, interfaces, and mixers). Select an icon for your device.

5 Select a device image and click Apply.

6 Close the AMS window to quit the AMS application.

The device names you enter appear as MIDI input and output choices in Pro Tools.

### MIDI Patch Name Support

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in /Library/Audio/MIDI Patch Names/Digidesign.

**To import MIDI patch names into Pro Tools:**

1. Verify the MIDI Device name in the Audio MIDI Setup window (see “Audio MIDI Setup” on page 35).

2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.

3. Click the Instrument or MIDI track Patch Select button.

---

*To use your own custom icons, you can place TIFF image files in /Library/Audio/MIDI Devices/Generic/Images, and they will appear as choices in the AMS device window.*
4 In the Patch Select dialog, click Change.

5 In the Open dialog, navigate to /Library/Audio/MIDI Patch Names/Digidesign/<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6 Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:

- In the Patch Select dialog, click Clear, and then click Done.

💡 MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
Appendix B

Configuring MIDI Studio Setup (Windows Only)

MIDI Studio Setup

MIDI Studio Setup (MSS) lets you configure the MIDI controllers and sound modules that are connected to your system, and control the routing of MIDI data between your MIDI equipment and Pro Tools.

MSS automatically finds MIDI interfaces, and lets you specify a custom name for each of the MIDI ports within the MIDI Studio Setup document.

MSS also supports XML-based patch file names for storing and importing patch names for your external MIDI devices.

Entire MIDI Studio Setup configurations created within MSS can be imported and exported.

MIDI Studio Setup Window

The MIDI Studio Setup window is organized into three sections. Interface controls are at the top of the window. All the currently defined instruments are displayed in the Instrument Name list on the left side of the window. A detailed view of MIDI parameters is shown in the Properties section on the right.
**Interface Controls**

**Create** Adds a new instrument to the Instrument Name list.

**Delete** Deletes the instrument or instruments selected in the Instrument Name list.

**Import** Imports an existing MIDI Studio Setup file.

**Export** Exports the current MIDI Studio Setup file.

**Show Duplicate Emulated Ports** When this option is selected and you are using a MIDI interface that supports timestamping (such as MIDI I/O), in addition to any MIDI ports on your interface, the MIDI Studio setup window shows both the DirectMusic time-stamped output ports, and non-stamped duplicate emulated output ports.

⚠️ Some MIDI Interfaces will not properly load or unload their drivers unless you quit and re-launch Pro Tools. Check the documentation that came with your MIDI interface for more information.

**Instrument List**

The Instrument list contains all the currently defined instruments. Selecting an instrument in the list displays that instrument’s properties in the Properties section of the window.

**Properties Section**

The Properties section lets you edit information for new instruments, or instrument currently selected in the Instrument list.

![MIDI Studio Setup Properties section](image)

When a previously defined instrument is selected in the Instrument list, the Properties section changes to reflect the properties of the selected instrument.

**To define an instrument with MIDI Studio Setup:**

1. Choose Setup > MIDI > MIDI Studio.
2. Click Create.
3. In the Instrument Name field, type the name of your instrument, and press Enter.

💡 If you do not enter an instrument name, the Instrument Name field will automatically inherit information from the Manufacturer and Model pop-up menu.

4. Set a manufacturer and model for the new device from the corresponding pop-up menus. If the Manufacturer and Model pop-up menus do not provide a name for your particular device, select None.
5. From the Input pop-up menu, select the input port on your MIDI interface that is connected to the MIDI Out of your instrument.
6 From the Output pop-up menu, select the output port on your MIDI interface that is connected to the MIDI In of your instrument.

7 Enable the appropriate MIDI channels (1–16) for the Send Channels and Receive Channels options (These determine which channels send and receive MIDI.)

**Instrument Name**

The Instrument Name field shows the user-definable instrument name for the currently selected instrument.

**Manufacturer**

The Manufacturer pop-up menu provides a list of MIDI equipment manufacturers. This list is derived from the XML-based MIDI device files.

> For more information, see “MIDI Patch Name Support” on page 41.

**Model**

The Model pop-up menu provides a list of MIDI devices, filtered by the manufacturer name. This list is derived from the XML-based MIDI device files provided with your Pro Tools installation.

> For more information, see “MIDI Patch Name Support” on page 41.

**Input Port**

The Input Port pop-up menu displays a list of available MIDI interface input ports. Inputs will include all MIDI interfaces enabled on your system. The MIDI interface port that is set and displayed here is the port through which MIDI data is sent from the external MIDI device specified in the Instrument Name field into your MIDI interface.

> If you set the input port to None, the defined instrument will not appear as a choice in a MIDI Input selector.

**Output Port**

The Output Port pop-up menu displays a list of available MIDI interface output ports. The port set and displayed here is the port through which MIDI data is sent from your MIDI interface to the MIDI device specified in the Instrument Name field.

> If you set the output port to None, the defined instrument will not appear as a choice in a MIDI Output selector.

**Send Channels**

The Send Channels grid sets the send channels for the MIDI device specified in the Instrument Name field.

**Receive Channels**

The Receive Channels grid sets the receive channels for the MIDI device specified in the Instrument Name field.

**MIDI Patch Name Support**

Pro Tools supports XML (Extensible Markup Language) for storing and importing patch names for your external MIDI devices. Pro Tools installs MIDI patch name files (.midnam) for the factory default patch names of many common MIDI devices. These files reside in directories, sorted by manufacturer, in C:\Program Files\Common Files\Digidesign\MIDI Patch Names\Avid.
To import MIDI patch names into Pro Tools:

1. Verify the MIDI Device name in the MIDI Studio Setup window (see “MIDI Studio Setup” on page 39).

2. Verify the Instrument or MIDI track output is correctly assigned to the MIDI device.

3. Click the Instrument or MIDI track Patch Select button.

4. In the Patch Select dialog, click Change.

5. In the Open dialog, navigate to C:\Program Files\Common Files\Digidesign\MIDI Patch Names\Digidesign\<name of manufacturer>, and select the MIDI Patch Name file (.midnam) for the MIDI device.

6. Click Open.

The Patch Select dialog is populated with patch names and the Patch Name Bank pop-up menu appears in the upper left hand corner of the window.

Patch Select dialog with patch names

Once patch names have been imported into Pro Tools, they are available for that MIDI device in all sessions.

To clear patch names:

- In the Patch Select dialog, click Clear and then click Done.

MIDI patch name files (.midnam) can be edited in any text editor, or you can use third-party patch librarian and editor software to create your own custom patch names.
It is recommended that you start with a newly formatted external or secondary internal audio drive. You should also periodically defragment your audio drive to ensure continued system performance.

⚠️ Always back up any important data on your drive before formatting it, as it will erase all data on the drive.

### Avoid Recording to the System Drive

Recording to your system drive is not recommended. Recording and playback on a system drive may result in lower track counts or fewer plug-ins.

### Supported Drive Formats and Drive Types

#### Drive Formats

**Mac** Mac systems should use drives formatted with HFS+ or HFS file system only.

⚠️ HFS drives are supported as Transfer drives only.

**Windows** Windows XP systems should use drives formatted as NTFS only.

⚠️ Windows systems can also support Mac drives formatted with HFS+ system (also commonly referred to as Mac OS Extended). Refer to the Pro Tools Reference Guide for more information (Help > Pro Tools Reference Guide).

Hard drive performance depends on factors including system configuration, number of tracks, session sample rate, density of edits, and the use of crossfades and other processes such as Beat Detective in a session.

For complete hard drive requirements, visit our website (www.avid.com).
SCSI Hard Drives

Avid recommends qualified SCSI hard drives and a qualified SCSI host bus adapter (HBA) card or (on Windows systems) a qualified built-in SCSI HBA connector on the motherboard.

For complete information on track count and the supported number and configuration of SCSI drives, visit our website (www.avid.com).

FireWire Hard Drives

Avid recommends qualified FireWire drives and (on Windows systems) a qualified FireWire host adapter.

For complete information on track count and the supported number and configuration of FireWire drives, visit our website (www.avid.com).

IDE/ATA/SATA Hard Drives

A qualified internal IDE/ATA/SATA drive may be used as a dedicated audio drive.

For complete information on track count with internal drives, visit our website (www.avid.com).

Formatting an Audio Drive

Formatting Mac Audio Drives

For optimum performance, audio drives should be formatted as Mac OS Extended (Journaled).

To format an audio drive:

1. Launch the Disk Utility application, located in Macintosh HD/Applications/Utilities.

2. Click the Erase tab.

3. Select the drive you want to initialize in the column on the left side of the window.

4. Choose the Mac OS Extended (Journaled) format.

Do not choose the “Case-Sensitive” format option. Pro Tools will not operate properly with case-sensitive formatted drives.

5. Type a name for the new volume.

6. If you plan to connect the drive to a Mac OS 9 computer, select Install Mac OS 9 Drivers. (Mac OS 9 options only appear in 10.5 or lower).

7. Click Erase.

The drive appears on the Desktop with the new volume name.
Formatting Windows Audio Drives

For optimal performance, audio drives should be formatted as NTFS.

⚠️ Pro Tools only supports Basic drive types. Do not convert the drive to a Dynamic type.

To format an audio drive (Windows 7, Windows Vista, and Windows XP):

1. Right-click Computer (Windows 7, Windows Vista) or My Computer (Windows XP) and choose Manage.

2. Under Storage, choose Disk Management.

3. If the volume is “Healthy,” do the following:
   - In the Disk Management window, right-click the hard drive you will use for audio and choose Format.
   - In the Format window, name the volume.
   - Choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select Perform a quick format.
   - Make sure Enable file and folder compression is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

4. If the volume is “Unallocated,” do the following:
   - In the Disk Management window, Right-click the hard drive you will use for audio and choose New Partition.
   - In the New Partition Wizard window, click Next.
   - When prompted, select the partition type.
   - Follow the on-screen instructions to select a partition size and other partition settings.
   - When prompted, choose a file system. For optimum performance, audio drives should be formatted as NTFS.
   - Select Perform a quick format.
   - Make sure Enable file and folder compression is not selected.
   - Set the Allocation unit size to Default.
   - Click OK.

Healthy volumes are volumes that have previously been partitioned and formatted.

Disk Management window (Windows XP)

Avid recommends using Primary partitions, instead of Extended partitions.
Partitioning Drives

Partitioning creates a logical volume or volumes on a physical drive, almost as if you were creating virtual hard drives. Partitions can then be formatted with the appropriate file system (NTFS for Windows, HFS+ for Mac (also referred to as Mac OS Extended (Journaled))).

⚠️ Mac OS allows drives larger than 4096 MB to be seen as whole volumes. Drives must be initialized with a disk utility that recognizes the 2 terabyte limit. Single Pro Tools audio files cannot exceed 3.4 GB in size.

⚠️ Windows XP allows drives formatted with the NTFS file system to be seen as whole volumes. Single Pro Tools audio files cannot exceed 3.4 GB in size.

Seek Times on Partitioned Drives

Seek times are actually faster on partitioned drives (assuming that reads and writes are performed on a single partition), since the heads only have to seek within the partition boundaries, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger partitions, but this comes at the expense of contiguous storage space. When you partition a drive, you will need to find the compromise that best suits your performance and storage requirements.

⚠️ Avoid distributing audio files within a session over different partitions on the same drive since this will adversely affect drive performance.

Mac Systems

When working with larger files (such as video), you can limit fragmentation by backing up your important files to another disk, erasing the files from the original hard disk, then copying the files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain system performance.

For maximum recording and playback efficiency, data should be written to your hard drive in a contiguous fashion—minimizing the seek requirements to play back the data. Unfortunately, your computer can’t always store the sound files in this way and must write to disk wherever it can find space.

In multitrack recording, audio tracks are written in discrete files, spaced evenly across the disk. While fragmentation of individual files may be zero, the tracks may be far enough apart that playback will still be very seek-intensive. Also, the remaining free space on the disk will be discontiguous, increasing the likelihood of file fragmentation on subsequent record passes.

Increased fragmentation increases the chance of disk errors, which can interfere with playback of audio, and result in performance errors.

💡 On Windows, to avoid fragmentation, format drives with higher cluster sizes (such as 32K).
Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize your drive, which rearranges your files into a contiguous format. Most optimizing software lets you run a check on a drive to find out the percentage of fragmentation. If your drive shows moderate to heavy fragmentation, you should consider optimizing it.

If you use your system for intensive editing, or if you frequently delete audio or fade files from your hard drive, you may need to optimize your drives on a weekly basis, or even every few days, since it doesn’t take long for even a large hard drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimization process, always make a backup copy of the data on your hard drive before you optimize it. You should also use a hard drive utility to find and repair any problems before optimizing data or re-initializing your drives. If there is any damage to your hard drive’s directories prior to optimizing, serious data loss may result.

Defragmenting Windows Audio Drives

To defragment an audio drive (Windows 7 and Windows Vista):

1 Click Start.

2 Type “disk defragmenter” in the search field at the bottom. “Disk Defragmenter” should appear at the top of the search results.

3 Click the Disk Defragmenter.

4 Click the Defragment disk button (Windows 7) or the Defragment now button (Windows Vista). Follow the on-screen instructions.

5 When defragmenting is complete, close the Disk Defragmenter window.

⚠️ In Windows 7 you can Ctrl-Click on the drive names to select multiple drives to defragment, and once more than one drive is selected, the button changes to “Defragment disks.”

⚠️ The “Defragment Now” (Vista only) command defragments all your hard drives. This can take a lot of time, especially on systems with multiple drives.

Advanced users can use the command line tool Defrag.exe to defragment individual drives. See your Windows Vista documentation for more information.

To defragment an audio drive (Windows XP):

1 Right-click My Computer and choose Manage.

2 Under Storage, choose Disk Defragmenter.

3 In the Disk Defragmenter window, choose the drive you want to defragment

4 Click the Defragment button and follow the on-screen instructions.

5 When defragmenting is complete, close the Computer Management window.
Hard Disk Storage Space

Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 7.5 MB per minute.

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 15 MB per minute.

Table 4 lists the required disk space for certain track numbers and track lengths, to help you estimate your hard disk usage.

Table 4. Required hard drive space for audio tracks (44.1 kHz and 48 kHz sessions shown)

<table>
<thead>
<tr>
<th>Number of Tracks and Length</th>
<th>16-bit at 44.1 kHz</th>
<th>16-bit at 48 kHz</th>
<th>24-bit at 44.1 kHz</th>
<th>24-bit at 48 kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 mono track, 1 minute</td>
<td>5 MB</td>
<td>5.5 MB</td>
<td>7.5 MB</td>
<td>8.2 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 5 minutes</td>
<td>50 MB</td>
<td>55 MB</td>
<td>75 MB</td>
<td>83 MB</td>
</tr>
<tr>
<td>1 stereo track (or two mono tracks), 60 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 5 minutes</td>
<td>600 MB</td>
<td>662 MB</td>
<td>900 MB</td>
<td>991 MB</td>
</tr>
<tr>
<td>24 mono tracks, 60 minutes</td>
<td>7 GB</td>
<td>7.8 GB</td>
<td>10.5 GB</td>
<td>11.6 GB</td>
</tr>
<tr>
<td>32 mono tracks, 5 minutes</td>
<td>800 MB</td>
<td>883 MB</td>
<td>1.2 GB</td>
<td>1.3 GB</td>
</tr>
<tr>
<td>32 mono tracks, 60 minutes</td>
<td>9.4 GB</td>
<td>10.4 GB</td>
<td>14 GB</td>
<td>15.4 GB</td>
</tr>
</tbody>
</table>
Resources

Whether you are new to Pro Tools or just starting out with your new system, we encourage you to read and utilize the many guides that Pro Tools provides. There are also useful online resources available, giving you everything from Pro Tools tips to Pro Tools answers.

About the Pro Tools Guides

In addition to any printed guides included with your system, PDF versions of the printed guides and many additional Pro Tools guides and Read Me files are installed automatically during Pro Tools installation (see “Documentation Installed Automatically with Pro Tools” on page 50). The PDFs are located in the Digidesign/Documentation folder on your local drive.

Printed copies of the Pro Tools Reference Guide and other guides in the Pro Tools guide set can be purchased separately from the Avid Store (http://shop.avid.com).

User Guide

The User Guide for your system gives you detailed instructions for setting up and configuring software and hardware for optimum performance.

Printed Intro to Pro Tools Guide

The printed Intro to Pro Tools has tutorials on using Pro Tools (such as recording in a Pro Tools session, importing audio from a CD, and creating an audio CD from a Pro Tools session).

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from the Pro Tools Help menu. (Choose Help, then select a guide.)

These include:

- *Pro Tools Shortcuts*, provides a complete list of keyboard and Right-click shortcuts for Pro Tools.
- *Audio Plug-Ins Guide*, describes the audio plug-ins included with Pro Tools for both real-time and file-based audio processing as well as many other paid plug-in option offered from Avid.
Documentation Installed Automatically with Pro Tools

When you install Pro Tools, you get useful PDF versions of many Pro Tools guides and Read Mes. This documentation can be found in the following locations:

Mac Applications/Digidesign/Documentation

Windows C:\Program Files\Digidesign\Documentation

To view or print PDF guides, you can use Adobe Reader (recommended) or Apple Preview (Mac only).

Read Me Files

These contain late-breaking information and known issues pertaining to Pro Tools software and hardware configurations. Read Me files are installed in the Documentation folder when you install Pro Tools.

Helpful Online Resources

Once you get going, here are some helpful online resources:

- For questions about installation, visit Avid’s online Knowledge Base. Go to: http://www.avid.com/onlinesupport
- Get useful information, help, and tips from the worldwide community of Pro Tools users at the online User Conference. Go to: http://duc.avid.com
- If you can’t find your answer on the User Conference or the Knowledge Base, contact Avid email support. Go to: http://www.avid.com/support

About www.avid.com

The Avid website (www.avid.com) is your best online source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Product Registration Register your purchase online.

Support and Downloads Contact Avid Customer Success (technical support); download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Knowledge Base or join the worldwide Pro Tools community on the User Conference.

Training and Education Study on your own using courses available online or find out how you can learn in a classroom setting at a certified Pro Tools training center.

Products and Developers Learn about Avid products; download demo software or learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Avid or sign up for a Pro Tools demo.
# index

## A
- Audio MIDI Setup (AMS) (Mac) 35
- authorizing Pro Tools
  - Mac 8
  - Windows 15
- Avid
  - customer success 50

## C
- Cache Size 24
- Clean Uninstall (Mac) 10
- Clock Source 26
- Connect your M-Audio interface 7, 13
- CPU Usage Limit 21, 22

## D
- DAE Playback Buffer Size 23
- drive formatting
  - Mac 44
  - Windows 45
- drive maintenance 43
- drive requirements 3

## E
- Energy Saver (Mac), turning off 28

## F
- FireWire requirements 44

## H
- hard drives
  - drive formats 43
  - FireWire requirements 44
  - formatting 44, 45
  - formatting (Mac) 44
  - IDE/ATA requirements 44
  - maintenance 43, 46
- optimizing 46
- partitioning 45
- requirements 3
- SCSI requirements 44
- space requirements 48
- Hardware Buffer Size 20
- Hardware Setup dialog 25

## I
- I/O Setup 27
- IDE/ATA requirements 44
- Ignore Errors During Playback/Record option 22
- install the driver 6, 12
- installing Pro Tools
  - Mac 7
  - Windows 13
- installing QuickTime (Windows) 15

## J
- journaling (Mac), enabling 30

## K
- key commands 4

## M
- M-Audio Control Panel 25
- M-Audio Driver Disc 6, 12
- MIDI
  - setup (Mac) 35
  - setup (Windows) 39
- MIDI Studio Setup (MSS) (Windows) 39
- Minimize Additional I/O Latency option 23

## N
- network cards (Windows), disabling 32
optimizing hard drives 46

partitioning hard drives 45
Playback Engine
   RTAS Processors setting 21
Plug-in Streaming Buffer 25
Plug-in Streaming Buffer Size 24
plug-ins
   multiprocessors 21
   RTAS Processors setting 21
pre-existing M-Audio drivers 5, 11
Pro Tools
   capabilities 1
   configuration (Windows) 20
demo session (Windows) 9, 16
   installing (Mac) 7
   installing (Windows) 13
   removing (Mac) 10
   removing (Windows) 17
Processor Scheduling performance (Windows) 33
Program Change dialog 38, 42

QuickTime
   installing (Windows) 15

removing Pro Tools
   Mac 10
   Windows 17
RTAS Processors setting 21

Safe Uninstall (Mac) 10
SCSI requirements 44
Software Update (Mac), turning off 28
Spotlight indexing (Mac), disabling 30
Startup items (Windows), disabling 33
system
   optimization (Mac) 28
   optional optimizations (Windows) 32
   recommended optimizations (Windows) 32
   required optimizations (Windows) 30
   shutting down 19
   starting up 19
system optimization
   Mac 28
   Windows 32
system settings
   Cache Size 24
   Clock Source 26
   CPU Usage Limit 22
   Hardware Buffer Size 20
   I/O Setup 27
   Plug-in Streaming Buffer 25
   Plug-in Streaming Buffer Size 24

technical support 50

uninstalling Pro Tools
   Mac 10
   Windows 17
User Account Control (UAC)
   disabling 32

website 50